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ВВЕДЕНИЕ

Учебное пособие посвящено изучению систем автоматического
управления с использованием в учебном процессе современного аппарата
информационных технологий. Использование интегрированной среды
MATLAB-Simulink с огромным набором инструментальных средств,
предоставляет студенту исследовательский аппарат, позволяющий глубже
изучить и провести расширенный анализ систем автоматического управления.

Лабораторные работы представлены по основным разделам курсов
«Основы теории автоматического управления», «Теория автоматического
управления», «Системы автоматического управления», «Моделирование
систем». Освещены вопросы исследования линейных, нелинейных дискретных
систем автоматического управления.

В качестве материалов для подготовки к лабораторным работам в
пособии кратко изложены существо обсуждаемых методов и основные
расчетные соотношения, что позволяет пользоваться методическим пособием,
наряду с дополнительными литературными источниками.

Показаны приемы работы с пакетом  MATLAB-Simulink при решении
различных задач исследования точности, устойчивости автоматических систем
управления, синтеза и коррекции динамических характеристик систем.

Пособие предназначено для студентов, изучающих соответствующие
дисциплины и для преподавателей, ведущие курсы по системам
автоматического управления.
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Лабораторная работа № 1

МОДЕЛИРОВАНИЕ  ЛИНЕЙНЫХ  СИСТЕМ АВТОМАТИЧЕСКОГО
УПРАВЛЕНИЯ

1. ЦЕЛЬ РАБОТЫ
Изучить пакет моделирования MATLAB-Simulink. Освоить основные

приемы моделирования линейных систем автоматического управления.

2. УКАЗАНИЯ К САМОСТОЯТЕЛЬНОЙ РАБОТЕ
До начала работы необходимо по литературе [1], [2] и по данному

методическому пособию изучить принципы работы, возможности
интегрированного пакета MATLAB-Simulink, а также принципы
математического моделирования  систем автоматического управления.

3. ОСНОВНЫЕ СВЕДЕНИЯ
Модель как средство осмысления помогает выявить взаимозависимости

переменных, характер их изменения во времени, найти существующие
закономерности. При составлении модели становится более понятной
структура исследуемого объекта, вскрываются важные причинно-следстенные
связи. В процессе моделирования постепенно происходит разделение свойств
исходного объекта на существенные и второстепенные с точки зрения
сформулированных требований к системе. Также, модель как средство
прогнозирования позволяет предсказывать поведение объекта и управлять им,
испытывая различные варианты  управления.

Модели можно условно разделить на три группы: физические,
аналоговые и математические. Физическими принято называть такие модели
(макеты), в которых реальный объект заменен его увеличенной или
уменьшенной копией. Аналоговое моделирование основано на замене
исходного объекта объектом другой физической природы, обладающим
аналогичным поведением. Математическая модель является математическим
описанием реального физического объекта.

Свойства объекта, представленного математической моделью, могут
изучаться с использованием аналитических и вычислительных методов.
Аналитические методы исследования математических моделей  имеют
существенные ограничения. Они позволяют в полной мере исследовать
системы, которые описываются дифференциальными уравнениями первого и
второго порядка. Системы, описываемые уравнениями третьего и четвертого
порядка, поддаются аналитическому решению, но влияние параметров системы
приходится исследовать уже численными методами. Системы более высоких
порядков исследуются только численными методами.
Численные методы базируются на использовании компьютерного
моделирования. Компьютерная модель — это программная реализация
математической модели, дополненная различными служебными программами
(например, рисующими и изменяющими графические образы во времени). Для
исследования динамических систем широко используются пакеты MATLAB-
Simulink фирмы Math Work. При моделировании с использованием Simulink
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реализуется принцип визуального программирования, в соответствии с
которым, пользователь на экране из библиотек стандартных блоков создает
модель устройства и осуществляет расчеты. При этом, в отличие от
классических способов моделирования, пользователю не нужно досконально
изучать язык программирования и численные методы математики, а достаточно
общих знаний требующихся при работе на компьютере и, естественно, знаний
той предметной области,  в которой он работает.

Наиболее распространенными способами математического описания
систем автоматического управления являются:

· дифференциальные уравнения, записываемые в той или иной форме;
· уравнения  состояний - система дифференциальных уравнений,

записанных в нормальной форме Коши;
· передаточные функции;
· системные функции (амплитулно-частотные, фазо-частотные,

амплитудно-фазовые характеристики);
· нули и полюсы передаточной функции.

Дифференциальное уравнение, описывающее линейную динамическую систему
(или ее часть),  в общем случае имеет вид:

1 1

1 1 0 1 1 01 1

n n m m

n n m nn n m m

d x d x dx d u d u da a a a x b b b b u
dt dt dt dt dt dt

- -

- -- -+ + ××× + += + + ×××+ + .  (1.1)

где u-входной сигнал, x-переменная состояния.

Это же уравнение в операторной форме можно записать в виде:
1 1

1 1 0 1 1 0
n n m m

n n n ma s x a s x a sx a x b s u b s u b su b u- -
- -+ + × × × + + = + + × × × + + ,(1.2)

где
k

k
k

ds
d t

= - оператор дифференцирования. Из последнего уравнения

находится отношение выходного сигнала к входному
1

1 1 0
1

1 1 0

( )
m m

n m
n n

n n

b s b s b s bxw s
u a s a s a s a

-
-

-
-

+ + ××× + +
= =

+ + ×××+ + .                          (1.3)

Выражение 1.3, совпадающее по форме с передаточной  функцией, назовем
операторной передаточной функцией. Заметим, что модели пакетов MATLAB-
Simulink оперируют именно с операторным представлением
дифференциальных уравнений.

Уравнения состояний (система дифференциальных уравнений,
записанных в нормальной форме Коши)  имеют вид:

,

,

dX AX BU
dt

Y CX DU

= +

= +
                                           (1.4)

где  X- вектор состояния; U,Y - векторы входа и выхода системы; A-матрица
коэффициентов, B-матрица управления, C-матрица выхода, D-матрица,
характеризующая связь входного сигнала с выходным.

В частном случае, в простых системах, выход является скалярной
величиной. В этом случае матрица С - это вектор строка, а матрица X – вектор
столбец и их произведение дает скалярную величину.
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Передаточная функция (отношение преобразованного по Лапласу
выходного сигнала к преобразованному по Лапласу входному сигналу),
составленная по уравнению 1.1 записывается в виде:

1
1 1 0

1
1 1 0

( )( )
( )

m m
n m

n n
n n

b s b s b s bX sW s
U s a s a s a s a

-
-

-
-

+ + ×× ×+ +
= =

+ + ×× ×+ +
,                                (1.5)

где s a jw= + - комплексная величина. Если принять s jw= , то получим
системную функцию (амплитудно–фазовую характеристику).

1
1 1 0

1
1 1 0

( ) ( ) ( )( )( )
( ) ( ) ( ) ( )

m m
n m

n n
n n

b j b j b j bX jH j
U j a j a j a j a

w w www
w w w w

-
-

-
-

+ + ×××+ +
= =

+ + ×××+ +
(1.6)

Системная функция может быть записана в алгебраической или
показательной форме как:

( )( ) Re[ ( )] Im[ ( )] ( ) jH j H j H j A e j ww w w w= + = ,            (1.7)

где 2 2( ) Re[ ( )] Im[ ( )]A H j H jw w w= +                                                      (1.8)
амплитудно–частотная характеристика,

Im[ ( )]( )
Re[ ( )]

H jarctg
H j

wj w
w

=                                         (1.9)

фазо–частотная характеристика.
Числитель и знаменатель передаточной функции (1.5) представляют

собой полиномы переменной s. Корни полинома числителя обращают
выражение в ноль и потому называются нулями (Zero), а корни полинома
знаменателя обращают выражение в бесконечность и называются полюсами
(Pole) передаточной функции. Передаточная функция, записанная при
использовании нулей (z) и полюсов (p), представляется в виде:

1 1

1 1

( )( ) ( )( )
( )( ) ( )

m m

n n

s z s z s zW s K
s p s p s p

-

-

- - × × × -
=

- - × × × -
                     (1.10)

где К – коэффициент усиления.

4. ЗАДАНИЕ
4.1. Используя Приложение А изучить пакет MATLAB-Simulink.
4.2. По варианту предложенному преподавателем выбрать из таблицы 1.1.

задание и на рабочей области пакета MATLAB-Simulink и с помощью
библиотек стандартных блоков и представленных уравнений построить схему
моделирования линейной системы автоматического управления.

4.3. Моделирование произвести для нулевых начальных условий и при
подаче на вход системы ступенчатого сигнала – возмущение по нагрузке –
(блок Step библиотеки Sources) u = 1(t) и  синусоидального сигнала (блок Sine
Wave библиотеки Sources)  u = 2cos(t).

4.4. Выход модели подключить к рабочему окну (блок To Workspace
библиотеки Sinks) и графическому дисплею (блок Scope библиотеки Sinks). На
графический дисплей выводить графики сигналов y(t) и u(t). Временные
интервалы фиксирования выбрать самостоятельно.
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4.4. Осуществить моделирование свободного движения системы с
нулевыми и ненулевыми начальными условиями (см. табл.1.2). Снять выходные
характеристики y(t) системы. Получить фазовый портрет.

4.5. Скопируйте полученные графики в отчет в формате Word. Для этого
в меню File выберите пункт Print to Figure.   В появившемся новом окне
графика переходного процесса выберите в меню Edit  пункт Copy Figure, а
затем в документе  Word вставьте график клавишами Ctrl + V.

Таблица 1.1
Варианты параметров моделей

Вариант порядок модели, n a0 a1 a2 b0 b1 b2

1 3 9 6 3 12 2 0,1
2 3 5 4 3 2,5 2 3
3 3 5 4 2 7,5 0 5
4 3 8 6 2 12 1 10
5 3 7 5 10 10 3 1,5
6 3 15 5 0 15 0,5 1
7 2 7 3 0 10 6 0
8 2 2 0,5 0 4 2 0
9 2 1 0,5 0 25 2 0
10 2 25 1 0 30 2 0
11 2 30 0,8 0 7,5 3 0
12 2 8 6 0 12 2 0
13 2 7 5 0 10 2 0
14 2 15 5 0 15 0 0
15 2 0,1 1 0 0,1 1 0

Таблица 1.2
Варианты начальных условий моделей

В
ар

иа
нт

1 2 3 4 5 6 7 8 9 10 11 12 13 14 15

П
ор

яд
ок

м
од

ел
и

n

3 3 3 3 3 3 2 2 2 2 2 2 2 2 2

y(0) 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1

y(1)

(0) 0,5 -0,2 -0,4 0,1 -0,5 0,5 0,4 1 -0,5 0 0,5 0,1 -0,5 0,5  0

y(z)

(0) 0 0,1 0,2 -0,1 0 0,1 - - - - - - - - -
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5. СОДЕРЖАНИЕ ОТЧЕТА
Отчет должен содержать следующие разделы:
1. Титульный лист
2. Цель и порядок выполнения работы.
3. Краткое изложение теоретической части.
4. Математическая модель системы автоматического управления.
5. Расчет начальных условий интеграторов.
6. Графики переходных процессов.
7. Выводы.

6. КОНТРОЛЬНЫЕ ВОПРОСЫ
6.1. Суть и виды моделирования.
6.2. Назовите виды математических моделей.
6.3. Какие существуют способы математического описания систем

автоматического управления?
6.4. Для решения каких задач используется пакет MATLAB-Simulink?
6.5. Для чего используются блоки интегрирования?
6.6. Поясните принцип составления модели вход – выход.

Лабораторная работа № 2

ПЕРЕХОДНЫЕ  ХАРАКТЕРИСТИКИ  ТИПОВЫХ  ДИНАМИЧЕСКИХ
ЗВЕНЬЕВ  СИСТЕМ АВТОМАТИЧЕСКОГО УПРАВЛЕНИЯ

1. ЦЕЛЬ РАБОТЫ
Изучение типовых динамических звеньев систем автоматического

управления и исследование их переходных характеристик и динамических
свойств.

2. УКАЗАНИЯ К САМОСТОЯТЕЛЬНОЙ РАБОТЕ
Необходимая информация для подготовки к настоящей лабораторной

работе отражена в теме: «Типовые динамические звенья» в литературе по ТАУ.

3. ОСНОВНЫЕ СВЕДЕНИЯ
Любую сложную систему автоматического управления можно

представить как произведение передаточных функций элементарных типовых
динамических звеньев. Типовыми динамическими звеньями называются
простейшие составные части систем автоматического управления, поведение
которых описывается обыкновенными дифференциальными уравнениями не
выше 2-ого порядка:

(2) (1) (1)
2 1 0 1 0a y a y a y b u b u+ + = + ,         (2.1)

где y и u – соответственно выходная переменная и управляющее воздействие
звена; ai и bi – постоянные коэффициенты.

Уравнение (2.1) в операторной форме записывается следующим образом:
2

2 1 0 1 0a p у a pу a y b pи b u+ + = + ,         (2.2)
Передаточную функцию W(p) звена, при нулевых начальных условиях

для уравнения (2.2) можно записать:
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1 0
2

2 1 0

( ) y b p bW p
u a p a p a

+
= =

+ +
.         (2.3)

Наличие нулевых корней в числителе или знаменателе передаточных
функций типовых звеньев – это признак для разбиения последних на три
группы:

· Позиционные звенья – не имеют нулевых корней, и, следовательно, в
области низких частот (т.е. в установившемся режиме), имеют
коэффициент передачи равный к 0.

· Интегрирующие звенья – имеют нулевой корень-полюс, и, следовательно,
в области низких частот, имеют коэффициент передачи, стремящийся к
бесконечности.

· Дифференцирующие звенья – имеют нулевой корень-ноль, и,
следовательно, в области низких частот, имеют коэффициент передачи,
стремящийся к нулю.
Динамические свойства звеньев определяются по их реакции на типовое

входное воздействие. Наиболее простым типовым воздействием является
единичная ступенчатая функция 1(t), удовлетворяющая условиям

0, 0
1( )

1, 0
если t

t
если t

ì <ï= í
³ïî

.         (2.4)

Одной из реакций звена является переходная функция h(t) – изменение
выходной переменной во времени при подаче на вход звена единичной
ступенчатой функции 1(t). Переходная функция характеризует переход звена
(системы) от одного равновесного состояния или установившегося режима к
другому.

В таблице 2.1. показаны передаточные функции и переходные функции
некоторых из типовых динамических звеньев.

Таблица 2.1
Название звена Передаточная функция Переходная функция

Апериодическое
звено первого
порядка

( )
1+

=
Tp

kpW ( ) (1 ) 1( )
t
Th t k e t

-
= - ×

Колебательное
звено ( )

1222 ++
=

TppT
kpW
x

( ) 1 (cos sin 1( )th t к e t t tg g
w w

w
-é ù= - + ×ê úë û

0
1
T

w = – частота свободных колебаний

при отсутствии затухания;
ζ – коэффициент затухания (0< ζ<1)

Интегрирующее
звено

( )
p
kpW = ( ) 1( )h t кt t= ×

Интегрирующее
звено с
замедлением

( ) ( )1+=
Tpp

kpW ( ) 1( )h t кt t= ×
Реальное
дифференцирующе
е звено

( )
1+

=
Tp

kppW ( ) 1( ).
t
Tкh t e t

T
-

= ×
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4. ЗАДАНИЕ
4.1. Используя возможности пакета MATLAB-Simulink построить схемы

моделирования динамических звеньев:
· апериодического первого порядка;
· колебательного;
· интегрирующего;
· интегрирующего с запаздыванием;
· реального дифференцирующего.

Из библиотеки MATLAB-Simulink необходимо выбрать библиотеку
Continuous соответствующий линейным системам, где предлагаются блоки с
различной передаточной функцией, из которых при помощи опции Block
parameters можно получить разновидности передаточных функций. А
параметры звеньев установите в соответствии с вариантом задания (см. табл.
2.2.)

4.2. При проведении моделирования на вход динамического звена
подается стандартный единичный сигнал, который выбирается из библиотеки
Sources в виде блока Step. А на выходе устанавливается графический
осциллограф (блок Scope библиотеки Sinks). Для осуществления моделирования
необходимо на панели меню выбрать Simulation, и на раскрывшемся окошке
нажать кнопку Start. Снятие переходных характеристик типовых динамических
звеньев осуществить через графический осциллограф Scope. Скопируйте
полученные графики в отчет в формате Word. Для этого в меню File выберите
пункт Print to Figure. В появившемся новом окне графика переходного
процесса выберите в меню Edit  пункт Copy Figure, а затем в документе  Word
вставьте график клавишами Ctrl + V.

4.3. Для колебательного звена определить значение коэффициента
затухания ζ, при котором время переходного процесса будет минимальным.

4.4. Провести анализ полученных результатов моделирования
Таблица 2.2

Параметры динамических звеньев
Варианты 1 2 3 4 5 6 7 8 9 10 11 12 13 14 15

k 7 2 5 4 1,5 3 10 14 5 4 1 2 5 1 10
T 0,4 0,1 0,3 1 0,2 3 5 5 1 0,4 0,2 0,2 2 0,1 5
T1 0,3 0,3 0,5 2 0,4 6 3 6 2 0,2 0,3 0,25 3 0,2 4
T2 1,3 1 0,4 0,8 0,45 1 1,1 1,41 1 0,3 0,35 0,3 1,3 0,8 1
ζ 055 0,3 0,4 0,5 0,25 0,2 0,25 0,3 0,4 0,6 0,5 0,55 0,2 0,3 0,4

5. СОДЕРЖАНИЕ ОТЧЕТА
Отчет должен содержать следующие разделы:
1. Цель и порядок выполнения работы.
2. Краткое изложение теоретических материалов.
3. Математические модели типовых динамических звеньев.
4. Графики переходных характеристик указанных типовых звеньев.
5. Выводы.
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6. КОНТРОЛЬНЫЕ ВОПРОСЫ
6.1. Что общего в виде передаточных функций типовых динамических

звеньев?
6.2. Какому динамическому звену соответствует переходная функция

( ) (1 ) 1( )
t

Th t k e t
-

= - ×  Определить параметры этого звена.
6.3. Динамическое звено описывается дифференциальным уравнением

(2) (1)4 3y ay y u+ + = . Найти значение параметра a, при котором звено будет
колебательным.

Лабораторная работа № 3

ИССЛЕДОВАНИЕ ТОЧНОСТИ СИСТЕМ  АВТОМАТИЧЕСКОГО
УПРАВЛЕНИЯ

1. ЦЕЛЬ РАБОТЫ
Исследование точности систем автоматического регулирования в

различных типовых режимах.

2. УКАЗАНИЯ К САМОСТОЯТЕЛЬНОЙ РАБОТЕ
При подготовке к лабораторной работе необходимо изучить тему:

«Точность систем автоматического управления в типовых режимах» [1], [2]. В
соответствии с вариантом задания составить схемы моделей и произвести
расчет параметров систем автоматического регулирования.

3. КРАТКИЕ ТЕОРЕТИЧЕСКИЕ СВЕДЕНИЯ

Одним из основных требований, предъявляемых к САУ является
 точность воспроизведения задающего воздействия, которая
определяется формой установившегося процесса управления (y(t)). При этом
установившаяся ошибка системы будет

( ) ( ) ( )tgtyt -=e . (3.1)
Установившееся значение ошибки в САУ можно определить

воспользовавшись теоремой о предельном значении оригинала из
операционного исчисления.

Если функции ( )te  и ( )te&  - оригиналы и E(P) – изображение
функции ( )te , то

( ) устPP
tPEP ee ==*

¥®®
lim)(lim

0
. (3.2)

Обычно точность САУ определяют для типовых режимов работы.
Простейшими из них являются режимы:

- при постоянной величине внешнего воздействия;
- при изменении внешнего воздействия с постоянной скоростью;
- при квадратично нарастающем изменении внешнего воздействия;
- при гармоническом воздействии.
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A. Найдем значение установившейся ошибки в замкнутой САУ при
постоянной величине внешнего задающего воздействия g(t) = const = g0.

Пусть передаточная функция разомкнутой цепи – W(p). Тогда
передаточная функция замкнутой системы для ошибки будет равна:

( )
)(1

1
PW

PФ g +
=e . (3.3)

Согласно теореме о предельном значении оригинала (3.2), выражение
установившейся ошибки принимает вид:

)(Ф(P)lim g0P
PGPуст ee **=

®
. (3.4)

При
P
g(P) 0=G  и

)(
)()(
PQ

KPMPW *
= , где M(P) и Q(P) не содержат

множителя P, с учетом (3.2) получим:

K
g

уст +
=

1
0e .  (3.5)

Это значение ошибки называется статической ошибкой.

B. Пусть задающее воздействие изменяется с постоянной скоростью
tVtg *=)( . (3.6)

По формулам (3.2) и (3.3), с учетом того, что в этом случае 2)(
P
VPG = ,

найдем:

.
)(1

1lim
)(1

1lim
020P PWP
V

PWP
VP

Pуст +
*=

+
**=

®®
e  (3.7)

Чтобы ликвидировать нарастание ошибки в этом случае, передаточная
функция разомкнутой цепи САУ – W(P) должна иметь нулевой полюс. Тогда,

как следует из формулы  (3.7), получим K
V

уст =e . Это постоянное значение

ошибки называется скоростной ошибкой.

Например. Пусть )1(
)(

+
=

Tpp
KPW   (один нулевой полюс).

Тогда из (3.7) получим

.
)1(

)1(lim
0P K

V
KTpp

Tpp
p
V

уст =
++

+
*=

®
e

Если в этом примере задающее воздействие постоянное, то
установившаяся ошибка в САУ будет равна нулю

.0
)1(

)1(lim 0

0P
=

++
+

**=
® KTpp

Tpp
p

gpустe

Итак, система, имеющая нулевой полюс в передаточной функции
разомкнутой цепи W(p), не будет иметь статической ошибки и даст постоянное
значение скоростной ошибки.
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Такая система называется астатической системой. В передаточной
функции разомкнутой цепи W(p) необходимо присутствие интегрирующего
звена.

Следящие системы и системы программного управления должны
проектироваться как астатические. Системы, настраиваемые на поддержание
постоянного значения регулируемой величины, могут иметь и статические
ошибки.

В следящей системе интегрирующим звеном, создающим астатизм,
является исполнительный двигатель. Угол поворота вала (или линейное
перемещение) будет пропорционален интегралу от входного управляющего
сигнала (напряжения).

Как видно из формул ошибок (3.5) и (3.7), для уменьшения величины
ошибки надо увеличивать общий коэффициент усиления К разомкнутой
цепи системы. Поэтому величина   К именуется добротностью системы.
Можно строить САУ также с астатизмом второго и более высокого порядка и
не только по отношению к задающему воздействию, но и по отношению к
возмущающему воздействию. Условие астатизма при этом будет другим и
будет определяться из условия.

)(Ф(p)lim f0
pFp

Pуст ee **=
®

(3.8)
C. Точность при гармоническом воздействии. Установившаяся ошибка в

этом случае определяется частотными характеристиками замкнутой системы,
рассмотренными ранее.

Пусть входное воздействие изменяется по закону
tgtg pm wsin)( =  . (3.9)

В линеаризованной системе в установившемся режиме ошибка будет
меняться также по гармоническому закону

( )jwee += tt pm sin)(  . (3.10)
Точность САУ в этом режиме можно определить по амплитуде ошибки,

воспользовавшись определением АЧХ замкнутой САУ по ошибке

)(1 p

m
m jW

g
w

e
+

= .  (3.11)

Обычно система управления проектируется таким образом,
чтобы me была много меньше амплитуды входного сигнала . Следовательно,

должно выполняться условие 1)(1 >>+ pjW w  на рабочей частоте pw . Тогда
выражение (3.11) можно заменить приближенным

)( p

m
m jW

g
w

e =  . (3.12)

Эта формула позволяет вычислить амплитуду ошибки в установившемся
режиме, а также решить задачу синтеза САУ, обеспечивающую
заданную точность в установившемся режиме. Например, при построении
желаемой ЛАЧХ на частоте управляющего воздействия (рабочей частоте - pw )
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при заданной амплитуде входного воздействия -  и допустимой амплитуде
ошибки - me определяется, так называемая, контрольная точка с координатами

pw  и [ ]Дб
g

jW
m

m
p e

w lg20)(lg20 = .  Желаемая ЛАЧХ должна пройти через эту

точку (или чуть выше). Часто при проектировании и
испытании систем управления пользуются синусоидальным задающим
сигналом и в том случае, когда требования к системе поставлены по
максимальной скорости и максимальному ускорению входного воздействия. В
этом случае можно определить эквивалентный синусоидальный сигнал.

Если tgtg pm wsin)( = , то скорость и ускорение будут

tgtg ppm ww cos)( =&  , tgtg ppm ww sin)( 2-=&& .
Следовательно,

pmgg w=max& ,
2

max pmgg w=&& .

Отсюда вычисляются частота pw  и амплитуда mg синусоидального
задающего воздействия, соответствующие требуемым максимальной скорости
и ускорению, а именно:

max

max

g
g

p &

&&
=w   ,

max

2

g
ggm &&

&
= . (3.13)

Эти значения используются для нанесения координат контрольной точки
на поле построения желаемой ЛАЧХ разомкнутого контура  системы
управления.

В этой лабораторной работе будут рассмотрены установившиеся ошибки
системы при постоянном, линейно-нарастающем и квадратично-нарастающем
внешнем воздействиях.

4. ЗАДАНИЕ
4.1. В соответствие со своим вариантом построить схему системы

показанной на рисунке 3.1. При исследовании системы с астатизмом нулевого
порядка принять R(p)= K и использовать в качестве внешнего задающего
воздействия только g=A, g=vt (параметры выбрать из таблиц 3.1), а при
исследовании астатических систем принять R(p)=K/p и использовать в качестве
внешнего задающего воздействия g=A, g=vt (параметры выбрать из таблиц 3.1)

и 2
2atg = (параметры выбрать из таблицы 3.2.).

Рис. 3.1. Структурная схема системы

g ye

)( pR )(0 pW

(-)
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где,
1

)(
2

2
1

1
0 ++

=
pTpT

KpW , R(p)=  K  – для системы с нулевым порядком

астатизма, R(p)= K/p – для астатической системы.
4.2. Провести исследование системы с нулевым порядком астатизма при

воздействии постоянного сигнала. Для этого необходимо с помощью пакета
MATLAB-Simulink собрать схему модели, как показано на рис. 3.2.
Генератором постоянного сигнала является блок Constant из библиотеки
Sources, параметром которого является постоянный сигнал g=A. Роль R(p)= K
играет усилитель Gain из библиотеки Math. Передаточная функция

1
)(

2
2

1

1
0 ++

=
pTpT

KpW реализуется с помощью блока Transfer Fcn библиотеки

Continuous, с помощью параметров которого в модель записываются K1, Т1,
Т2. На выходе устанавливается осциллограф Scope из библиотеки Sinks. Для
просмотра одновременно двух сигналов и их сравнения на его вход
одновременно подаем два сигнала: g =A (с выхода генератора сигнала
Constant); y(t) (c выхода системы). Такое позволяет сделать блок Mux (черный
четырехугольник на рисунке) из библиотеки Signals & Systems.

Рис. 3.2. Схема модели на MATLAB-Simulink для системы с нулевым порядком
астатизма при подаче на вход сигнала g=A

4.3. Изменяя  К = 1, 5, 10, получить переходные процессы и определить
предельные значения установившейся ошибки для каждого К.

4.4. Собрать аналогично п.п. 4.2. схему модели для системы с нулевым
порядком астатизма при подаче на вход линейно-нарастающего сигнала
g= v t, как показано на рис. 3.3. Для получения входного воздействия g=  v  t,
последовательно генератору постоянного сигнала соединяется блок Integrator
из библиотеки Continuous.

Рис. 3.3. Схема модели на MATLAB-Simulink для системы с нулевым порядком
астатизма при подаче на вход сигнала g = v t
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4.5. Также для трех значений К= 1, 5, 10 получить переходные процессы и
определить предельные значения установившейся ошибки для каждого К.

4.6. Исследование систем с астатизмом первого порядка. Для таких
систем R(p)= K/p и поэтому последовательно к усилителю Gain присоединяется
блок Integrator из библиотеки Continuous. Схема модели показана на рис. 3.4.
Квадратично нарастающее входное воздействие 2

2atg = можно получить, если
включить последовательно с генератором воздействующих сигналов два
интегратора. Параметры передаточной функции для соответствующих
вариантов показано в таблице 3.2. а параметры воздействующих сигналов  в
таблицах 3.1. и 3.2.

Рис. 3.4. Схема модели на MATLAB-Simulink для системы с астатизмом при подаче на
вход сигнала 2

2atg =  (в качестве примера на схеме показана передаточная функция

)5.0(
)1(2)(

+
+

=
pp
ppW )

4.7. Получить кривые переходного процесса для трех значений K(K=1, 5,
10) при подаче на вход системы сигнала g(t)=A и определить предельные
значения установившейся ошибки, затем тоже самое проделать для g(t)=V·t и

2
2atg = .

  4.8. По полученным данным проанализировать влияние параметров на
точность системы.

Таблица 3.1
Варианты параметров систем с нулевым порядком астатизма

Вариант К1 Т1 Т2 К
Типовые входные

воздействия
g=A g=vt

2
2atg =

1 1 0 3 1, 5, 10 1 t 0.2 2t
2 1.5 0 2.5 1, 5, 10 4 2t 0.25 2t
3 1.5 0 0.5 1, 5, 10 2 t 0.3 2t
4 2 0 1 1, 5, 10 2 2t 0.45 2t
5 3 0 1 1, 5, 10 1 2t 0.4 2t
6 2.5 0.5 5 1, 5, 10 1 0.5t 0.35 2t
7 2.5 2.5 3 1, 5, 10 2 4t 0.3 2t
8 8 0.5 3 1, 5, 10 2 t 0.2 2t
9 5 0.1 2 1, 5, 10 1 2t 0.2 2t
10 3 1 2 1, 5, 10 1 t 0.25 2t
11 1.5 1 0.7 1, 5, 10 2 3t 0.25 2t



18

12 2 1 0.6 1, 5, 10 2 2t 0.5 2t
13 3 2 2 1, 5, 10 2 2t 0.45 2t
14 4 2 3 1, 5, 10 1 0.5t 0.2 2t
15 5 1 0.5 1, 5, 10 2 2t 0.3 2t

Таблица 3.2
Варианты для исследования астатических систем

Вариант W0(p) 2

2
atg = Вариант W0(p) 2

2
atg =

1
2

3 1p +
20,2t 8 2

1
2 3 1

p
p p

+
+ +

20,25t

2
3

2 ,5 1p +
20,5t 9 2

2
0, 5 2 1

p
p p

+
+ +

20,2t

3
1,5

0,5 p
20,2t 10 2

2
0,5 2

p
p p

+
+ +

20,5t

4 2

1, 5
2 1

p
p p

+
+ +

20,4t 11 2

1, 5 8
0, 5 2 8

p
p p

+
+ +

20,3t

5 2

1
2

p
p p

+
+ +

20,3t 12 2

1
0,5 1

p
p p

+
+ +

20,45t

6 2

5
5 6

p
p p

+
+ +

20,45t 13 2

1
0,1 0 , 7 1

p
p p

+
+ +

20,4t

7 2

1, 5 8
0, 5 2 8

p
p p

+
+ +

20,25t 14 2

1, 5
2 1

p
p p

+
+ +

20,5t

5. СОДЕРЖАНИЕ ОТЧЕТА
Отчет должен содержать следующие разделы:
1. Титульный лист.
2. Цель и порядок выполнения работы.
3. Математические модели исследуемых систем и кривые переходных

процессов.
4. Графики экспериментально полученных зависимостей предельных

значений установившихся ошибок e  в зависимости от коэффициента К.
5. Выводы.

6. КОНТРОЛЬНЫЕ ВОПРОСЫ
7.1. Какие существуют типовые воздействия для исследования

точности?
7.2. С помощью какого блока Simulink реализуется увеличение порядка

астатизма в модели системы?
7.3. Как определить порядок астатизма системы автоматического

управления.
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Лабораторная работа № 4

АНАЛИЗ  УСТОЙЧИВОСТИ  ЛИНЕЙНЫХ  СИСТЕМ
АВТОМАТИЧЕСКОГО УПРАВЛЕНИЯ

1. ЦЕЛЬ РАБОТЫ
Исследование устойчивости САР с помощью критерия Найквиста и

изучение влияния на устойчивость системы ее параметров.

2. УКАЗАНИЯ К САМОСТОЯТЕЛЬНОЙ РАБОТЕ
При подготовке к данной лабораторной работе необходимо изучить тему

«Устойчивость систем автоматического управления».

3. ОСНОВНЫЕ  СВЕДЕНИЯ
Устойчивость – это свойство системы возвращаться в исходный или

близкий к нему установившийся режим после всякого выхода из него в
результате какого-либо воздействия.

Это понятие хорошо описывается тремя простыми примерами (рис.4.1):
1. Шар, находящийся на вершине горки (рис.4.1, а), является

примером неустойчивой системы, так как при приложении к нему конечного
возмущения (сторонней силы) он скатится с горки и в исходное положение не
вернется.

2. Шар, находящийся во впадине, является примером устойчивой
системы, так как при приложении к нему конечного возмущения он вернется в
исходное положение (рис.4.1, б).

3. Шар, находящийся на плоскости, является примером системы,
находящейся на границе устойчивости, так как при приложении к нему
конечного возмущения он остановится, но уже в другом положении (рис.4.1, в).

Рис.4.1. Пример, иллюстрирующий понятие устойчивости

Таким образом, если система неустойчива, то достаточно любого толчка,
чтобы в ней начался расходящийся процесс ухода из исходного
установившегося состояния. А если система устойчива, то переходный процесс
в системе, вызванный каким-либо воздействием, со временем затухает, и
система вновь возвращается в устойчивое состояние.

Устойчивость является основной оценкой динамических свойств систем
автоматического управления. Устойчивость систем автоматического
управления связана с характером её поведения после прекращения внешнего
воздействия. Это поведение описывается свободной составляющей решения
дифференциального уравнения, которое описывает систему. Если свободная

а)                                    б)                                      в)
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составляющая рабочего параметра объекта управления после прекращения
внешнего воздействия стремится к нулю, то такая система является устойчивой.
Другими словами,  устойчивость системы − это есть затухание ее переходных
процессов.

Оценка устойчивости производится на основе результатов исследования
свободной составляющей, которая представляет собой решение однородного
дифференциального уравнения (которое называется характеристическим) при
заданных начальных условиях:

 (a0sn+a1sn-1+...+an-1)y=0.                                   (4.1)
При этом система автоматического управления будет устойчива, если

переходный процесс, вызванный любым возмущением, будет затухающим, то
есть с течением времени будет стремиться к какому-то определенному
значению. Для выполнения этого условия необходимо, чтобы действительная
часть сопряженных корней характеристического уравнения системы была
отрицательной.

C целью упрощения анализа устойчивости систем разработан ряд
специальных методов, которые получили название критериев устойчивости.

Критерии устойчивости делятся на две разновидности: алгебраические и
частотные. Алгебраические критерии являются аналитическими, а частотные –
графоаналитическими. Критерии устойчивости позволяют также оценить
влияние параметров системы на устойчивость в виде запасов устойчивости.

В пакете Simulink возможно автоматическое применение трех критериев
устойчивости:

1) по корням характеристического уравнения системы;
2) частотные критерии устойчивости Найквиста;
3) критерий устойчивости Никольса.
Чаще применяются в основном первые два.
В пакете Simulink устойчивость системы по корням характеристического

уравнения определяется с использованием пакета расширения LTI Viewer путем
нажатия правой кнопки на поле графика и выбора пункта контекстного меню
Plot Type > Pole/Zero.

В пакете Simulink для определения устойчивости системы с наличием
обратной связи (замкнутой системы) по критерию Найквиста необходимо
разомкнуть цепь обратной связи, то есть превратить систему в разомкнутую.
Для этого нужно удалить одну из соединительных линий в цепи обратной связи
и переставить точку выхода.

В пакете Simulink устойчивость системы по критерию Найквиста
определяется с использованием пакета расширения LTI Viewer:

1) для АФЧХ: Plot Type > Nyquist ;
2) для ЛЧХ: Plot Type > Bode .
Для частотных критериев устойчивости Найквиста существуют два

показателя запасов устойчивости (рис.4.2.):
1) запас устойчивости по амплитуде DL, измеряемый в децибелах (дБ)

и показывающий, на сколько следует сдвинуть ЛАХ, чтобы система оказалась
на границе устойчивости (см. рис.4.2, пунктирная линия);
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2) запас устойчивости по фазе Dj, измеряемый в градусах и
показывающий, на сколько следует сдвинуть ЛФХ, чтобы система оказалась на
границе устойчивости (см. рис.4.2, пунктирная линия).

Запасы устойчивости получаются следующим образом (рис.4.2):
1) из точки пересечения ЛФХ, при окончательном ее спаде, c линией,

проведенной на уровне −180° (частота фазового сдвига), поднимается
перпендикуляр до пересечения с ЛАХ. Расстояние от этой точки до оси абсцисс
даст искомое значение запаса устойчивости по амплитуде (DL, дБ);

2) из точки пересечения ЛАХ оси абсцисс (частота среза) опускается
перпендикуляр до пересечения с ЛФХ, расстояние от этой точки до уровня
−180° даст искомое значение запаса устойчивости по фазе (Dj, °).

В пакете Simulink для получения ЛЧХ нужно в пакете LTI Viewer нажать
правой кнопкой мыши на график и выбрать пункт меню Plot Type > Bode.

Для определения запасов устойчивости необходимо выбрать пункт
контекстного меню Characteristics > Stability Margins (Min).

При этом в появляющихся окошках указаны численные значения запасов
и частота в соответствующих точках логарифмических частотных
характеристик:

· Gain margin (dB) – запас устойчивости по амплитуде, дБ;
· Phase margin (deg) – запас устойчивости по фазе, градусы;
· At frequency (rad/sec) – “на частоте”, рад/с.

Рис. 4.2. ЛАХ и ЛФХ системы

L, дБ

-j, °

DL, дБ

Dj, °

lg w, рад/с

lg w, рад/с

0

0

-180

wс

wp
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4. ЗАДАНИЕ

Рис. 4.3. Модель линейной системы автоматического управления

4.1. Собрать схему модели системы указанной на рис. 4.3 и в
соответствии с вариантом задания (таблица 4.1.) установить параметры модели.

4.2. Подав на вход единичный ступенчатый сигнал, получить переходную
характеристику САР. С помощью блока LTI Viewer определить устойчивость
системы по критерию Найквиста.

4.3. Получив графики ЛАХ и ЛФХ определить запасы устойчивости САР
по амплитуде и фазе. Определить запасы устойчивости:

· по амплитуде ∆L - это расстояние в децибелах от оси частот до
ЛАЧХ на частоте wp, на которой ЛФЧХ пересекает уровень - 1800.

· по фазе ∆φ. Это расстояние от ЛФЧХ до уровня –1800 на частоте
среза wср, когда ЛАЧХ пересекает ось частот.

4.4. Изменяя общий коэффициент усиления контура посредством
увеличения и уменьшения коэффициента усиления первого звена – К1, изучить,
как это сказывается на степени устойчивости системы. Контроль осуществлять
по переходной характеристике.

4.5. Определить оптимальное значение коэффициента усиления контура
К=К 1* К2*К3, при котором запасы по фазе и амплитуде войдут в
рекомендуемые диапазоны (Для получения системы управления хорошего или,
по крайней мере, удовлетворительного качества, необходимо выполнить три
условия:

· запас ∆ φ  устойчивости по фазе должен составлять 350..650 и
более;

· запас ∆L устойчивости по амплитуде должен быть 6..12..20 дБ и
более;

· если система статическая, то усиление ее контура должно
находиться в пределах 20..40 дБ.  см. выше)

Установить это значение усиления и построить переходную
характеристику оптимизированной САР, а также ЛАЧХ и ЛФЧХ.

4.6. Построить область устойчивости указанной системы по
коэффициенту усиления контура К=К1* К2*К3:

· Приняв К2= 1, К3=1, Т1=1. И изменяя К1 в соответствие с
таблицей 4.2. (согласно своего варианта).

· Изменяя Т1 и Т2 от 0.01 до 1.0 (0.01, 0.02, 0.04, 0.06, 0.08, 0.10 , 0.2,
0.4, 0.6, 0.8, 1.0) определить устойчива ли система, и заполнить таблицу 4.3.

4.7. Построить график-диаграмму области устойчивости САР при
заданном коэффициенте усиления.
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Таблица 4.1
Варианты задания

Вариант К1 К2 К3 Т1 Т2 Т3 Ко
1 6,5 7,7 2,4 0,01 0,43 5,45 0,25
2 6,3 6,2 2,9 0,03 0,5 8,2 0,25
3 8,0 7,5 2,5 0,012 0,43 6,0 0,25
4 7,2 7,6 2,6 0,018 0,44 7,0 0,25
5 6,8 6,9 2,4 0,019 0,45 6,8 0,25
6 7,7 7,3 2,7 0,02 0,46 6,2 0,25
7 8,1 6,5 2,8 0,025 0,44 7,6 0,25
8 6,9 6,3 2,6 0,017 0,49 7,9 0,25
9 7,2 6,9 2,8 0,014 0,48 8,1 0,25
10 6,6 6,4 2,7 0,029 0,47 8,0 0,25
11 7,8 7,2 2,9 0,023 0,49 7,4 0,25
12 7,9 7,8 2,4 0,03 0,5 7,6 0,25
13 6,9 6,5 2,5 0,017 0,47 7,7 0,25
14 6,8 6,3 2,6 0,024 0,48 8,0 0,25
15 7,1 6,2 2,7 0,013 0,45 8,1 0,25

Таблица 4.2
Коэффициент усиления контура

Вариант 1, 5, 7 2, 3, 6 4, 8, 12 9, 10, 15 11, 14, 13

К1 5 18 50 80 90

Таблица 4.3
Состояние устойчивости САР при различных

значениях постоянных времени
T3=0.01 T3=0.02 … T3=1.0

T2=0.01 Уст.
(неустойчива)

Уст.
(неустойчива)

T2=0.02

T2=0.04 Уст.
(неустойчива)

…

T2=1.0 Уст.
(неустойчива)

5. СОДЕРЖАНИЕ ОТЧЕТА
Отчет должен содержать следующие разделы:
1. Цель работы.
2. Описание критерия устойчивости Найквиста.
3. Задание на лабораторную работу.
4. Модель исследуемой системы.
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5. Результаты моделирования.
6. Выводы

6. КОНТРОЛЬНЫЕ ВОПРОСЫ
6.1. Сформулировать критерии устойчивости Гурвица, Михайлова,

Найквиста, логарифмический критерий.
6.2. Что такое коэффициент запаса устойчивости и как он определяется?
6.3. Какой блок MATLAB-Simulink используется для исследования

устойчивости по критерию Найквиста?
6.4. Какие запасы устойчивости следует обеспечить, чтобы качество САР

было удовлетворительным?

Лабораторная работа № 5

СИНТЕЗ И КОРРЕКЦИЯ ЛИНЕЙНЫХ  СИСТЕМ
АВТОМАТИЧЕСКОГО  УПРАВЛЕНИЯ

1. ЦЕЛЬ РАБОТЫ
Коррекция динамических свойств системы автоматического управления с

помощью регуляторов.

2. УКАЗАНИЯ К САМОСТОЯТЕЛЬНОЙ РАБОТЕ
При подготовке к лабораторной работе необходимо изучить тему:

«Синтез САУ при помощи регуляторов». К занятию составить схемы
моделирования исследуемых систем в соответствии с вариантом задания.

3. ОСНОВНЫЕ СВЕДЕНИЯ
Задача синтеза систем автоматического управления (коррекция их

динамических свойств) состоит в выборе структуры и параметров систем
регулирования объектами, которые в соответствии с заданными техническими
условиями обеспечивают наиболее рациональные характеристики по запасам
устойчивости и показателям качества.

Коррекция осуществляется с помощью введения в систему специальных
корректирующих звеньев с особо подобранной передаточной функцией.

Таким образом, задача синтеза включает в себя определение структуры и
параметров корректирующих звеньев при известных параметрах остальных
звеньев, входящих в систему, с учетом заданных технических условий.

Корректирующие звенья могут включаться последовательно, параллельно
и в обратной связи.

В непрерывных системах автоматического управления используется
множество типов корректирующих устройств и в общем случае их структура
может быть любой. Однако в теории автоматического управления выделяют
типовые корректирующие звенья, которые называются регуляторами.
Идеальные регуляторы нечасто используются на практике, а вместо них
используются реальные регуляторы, учитывающие свойство инерционности:
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Пропорциональные (П):

( ) ,
1sT

ksW
п

п
п +×

=  (5.1)

где Tп – постоянная времени пропорционального регулятора.
Пропорционально-дифференцирующие (ПД):

( ) ,
1sT
skk

sW
пд

дп
пд +×

×±
=     (5.2)

где Tпд – постоянная времени пропорционально-дифференцирующего
регулятора.

Пропорционально-интегрирующие (ПИ):

( ) ,
1sT

s
kk

sW
пи

и
п

пи +×

±
=    (5.3)

где Tпи – постоянная времени пропорционально-интегрирующего регулятора.
Пропорционально-интегродифференцирующие (ПИД):

( ) ,
1sT

sk
s

kk
sW

пид

д
и

п
пид +×

×±±
=          (5.4)

где Tпид – постоянная времени пропорционально-интегро-дифференцирующего
регулятора.

На рисунках 5.1, 5.2, 5.3, 5.4 показаны структурные схемы реальных
регуляторов в пакете MATLAB-Simulink.

Рис.5.1. Структурная схема реального П-регулятора в пакете Simulink

Рис.5.2. Структурная схема реального ПД-регулятора  в пакете Simulink

Рис. 5.3. Структурная схема реального ПИ-регулятора в пакете Simulink
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Рис.5.4. Структурная схема реального ПИД-регулятора в пакете Simulink

В данной лабораторной работе рассмотрим синтез корректирующих
звеньев в пакете Simulink (приложение SISO Design Tool) с помощью частотных
характеристик или изменения полюсов/нолей передаточной функции
корректирующего звена.

Это приложение основано на применении LTI Viewer,  входит в пакет
Control System и запускается из окна Launch Pad (Панель запуска) основного
окна MATLAB. Для запуска необходимо двукратное нажатие на опции Control
System Toolbox и выбор (двукратным нажатием) SISO Design Tool, после чего
должно появиться основное окно этого приложения.

Основное окно содержит в себе (рис.5.5):
1 − командное меню;
2 − панель инструментов;
3 − панель корректирующего звена;
4 − панель структуры системы;
5 − корневой годограф;
6 − логарифмическую амплитудную характеристику;
7 − логарифмическую фазовую характеристику;
8 − панель подсказок.

Рис.5.5. Основное окно приложения SISO Design Tool

1

2
4

3

5

6

7

8
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Рис.5.6. Панель структуры  системы

После запуска SISO Design Tool следует сначала определить, как
выглядит модель, для которой составляется корректирующее звено. Она
представлена на панели структуры системы (рис.5.6).

Здесь введены следующие обозначения:
F – Prefilter (Префильтр) – передаточная функция совокупности звеньев,

стоящих между точкой приложения входного сигнала и сумматором;
C – Compensator (Корректирующее звено) – передаточная функция

синтезируемого звена;
G – Plant (Объект) – передаточная функция совокупности звеньев,

стоящих в прямой ветви;
H – Sensor (Датчик) – передаточная функция совокупности звеньев,

стоящих в обратной связи системы.
Все передаточные функции, кроме передаточной функции

корректирующего звена, являются постоянными и не изменяются в процессе
синтеза.

На этой же панели расположены две кнопки:
−  кнопка с обозначением “+/−” изменяет знак обратной связи системы;
−  кнопка с обозначением “FS” изменяет положение корректирующего звена  в
прямой ветви либо в обратной связи.

4. ЗАДАНИЕ
4.1. На структурной схеме (рис.5.7) представлена САР, представляющая

Рис.5.7. Структурная схема САРЧ

собой САУ по ошибке, в которую входят:
1) регулятор, cостоящий из усилителя представленный как Gain 1 (с
коэффициентом усиления равный единице) и regulator1(W= K/(T1s+1));
2) исполнительный механизм в виде интегрирующего звена (integrator
W=1/s)  и передаточной функции (Transfer Fcn1 W= 1.4/(0.26s+1));
3) объект управления, который представляет собой последовательно
соединенных усилителя (Gain Ko=0.1) и передаточной функции (Transfer
Fcn2 W= 15/(0.2s+1) );
4) обратная связь в виде усилителя (Gain2 Koc=1);
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5) также имеются сумматор, генератор входного воздействия и
осциллограф на выходе.
4.2. Для указанной САР произвести исследования динамических качеств

на соответствие  установленным ниже требованиям.
Требуется получить следующие характеристики САР:

1) запас устойчивости по амплитуде: не менее 20 дБ;
2) запас устойчивости по фазе: от 20 до 80 градусов;
3) статическая ошибка: от 0 до ±5%;
4) перерегулирование: не более 20%;
5) время переходного процесса: от 0,5 до 3 с.
Начальные параметры настройки регулятора K и T1 выбрать из таблицы

5.1  в соответствие с вариантом.
Таблица 5.1

Параметры исследуемого регулятора

Вариант Параметры регулятора Вариант Параметры регулятора
К Т1 К Т1

1 0,1 0,001 11 3 0,01
2 5 0,005 12 1 0,004
3 2 0,003 13 7,7 0,003
4 0,3 0,002 14 4 0,009
5 6 0,003 15 3,5 0,005
6 0,18 0,008 16 9,5 0,006
7 0,9 0,007 17 7 0,007
8 2,5 0,001 18 6,8 0,008
9 3,2 0,005 19 5,1 0,004

10 5,5 0,006 20 10 0,007
4.3. Получить характеристики САР и проанализировать их на

соответствие или не соответствие вышеуказанным требуемым
характеристикам.

При несоответствие указанных параметров настройки регулятора,
предложить оптимальные параметры регулятора при которых  все или
большинство характеристик САР будут находиться в указанных пределах.

5. ПОСЛЕДОВАТЕЛЬНОСТЬ  ВЫПОЛНЕНИЯ  РАБОТЫ
5.1. Для представления системы в виде, пригодном для ее синтеза в SISO

Design Tool необходимо выделить прямую ветвь структурной схемы и
регулятор в отдельности перенести их в рабочую область.

Для этого необходимо выделить:
1) Префильтр F – у данной системы нет звеньев, стоящих между

точкой приложения управляющего воздействия и сумматором, поэтому
передаточная функция префильтра равна единице.

2) Прямая ветвь G – для данной системы в прямой ветви находятся
исполнительный механизм и объект управления. Их следует скопировать со
структурной схемы САР в новое окно модели и установить точки входа и
выхода, как это показано на рисунках 5.8 и 5.10.
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5.2. Следующим этапом необходимо вызвать окно LTI Viewer (в окне
модели – Tools > Linear Analysis) и получить модель прямой ветви в этом
приложении (в окне LTI Viewer’а – Simulink > Get Linearized Model). При этом в
памяти

Рис.5.8. Структурная схема прямой ветви

образуется LTI-модель, адекватная структурной схеме прямой ветви. Теперь
необходимо перенести эту модель в рабочую область MATLAB, для этого
необходимо выполнить в окне LTI Viewer’а: File > Export…, в появившемся
окне (рис.5.9) выделить в разделе Export List нужную нам систему (для рис.5.9 –
reg_upr_1) и сохранить модель прямой ветви в рабочей области (Export to
Workspace) или на диске (Export to Disk). В последнем случае потребуется
введение имени для сохраняемой модели.

Рис.5.9. Окно экспорта модели LTI Viewer

3) Обратная связь H – у данной системы обратная  связь имеет
передаточную функцию, равную единице;

4) Регулятор С – порядок действий для переноса его в рабочую
область или на диск такой же, как и для прямой ветви (рис.5.10).

1. Запустить приложение SISO Design Tool и импортировать в него
полученные в предыдущем пункте модели.

Для запуска SISO Design Tool необходимо выполнить в панели Launch

Рис.5.10. Структурная схема регулятора

Pad основного окна MATLAB: Control System Toolbox > SISO Design Tool.
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В окне SISO Design Tool выполнить: File > Import…, в появившемся окне
можно задать имя системы (System Name) и следует выбрать, откуда ведется
импорт – из рабочей области (Workspace). В списке выбрать нужную нам
систему и нажать кнопку со стрелкой, стоящую напротив нужного нам
элемента системы (для прямой ветви – выбрать reg_upr_1 и нажать кнопку со
стрелкой напротив G (прямая ветвь). После этого в полях элементов системы
появится имя соответствующей модели. Так же импортируется и регулятор.

Так как в нашем случае в префильтре и обратной связи стоят звенья с
передаточными функциями, равными единице, то менять в элементах F и H
ничего не нужно (по умолчанию там стоят единицы).

После того как экспорт моделей всех элементов завершен, необходимо
нажать кнопку “ОК”.

После выполнения вышеописанных действий можно убедиться, что
внешний вид графиков изменился и передаточная функция регулятора именно
такая, какая нам нужна (в данном примере Wр(s) = kр × (1/(1+Ts)). Передаточная
функция регулятора (корректирующего звена) приводится в панели
корректирующего звена (см. рис.5.5, поз.3).

2. Добиться с помощью SISO Design Tool необходимых характеристик
системы.

Если нажать любой кнопкой мыши на неизменяемую часть системы
(блоки, обозначенные желтым цветом), то можно увидеть окно сведений по
синтезируемой системе (см. рис.5.11), вызываемое активизацией в окне SISO
Design Tool позиции View > System Data. При нажатии на блоке
корректирующего звена появляется окно редактирования корректирующего
звена (см. рис.5.12), вызываемое активизацией в окне SISO Design Tool позиции
Compensator > Edit.

Рис.5.11. Окно сведений по синтезируемой системе (System Data)



31

На логарифмических частотных характеристиках выводятся значения:
G.M. – запас устойчивости по амплитуде; P.M. – запас устойчивости по фазе;
Freq. – значение частоты в соответствующей точке; Stable/Unstable loop –
устойчивая/неустойчивая система.

Кроме того, на графиках логарифмических частотных характеристик
выводятся точки, характеризующие устойчивость системы (оранжевый цвет),
неизменяемую часть системы (синим цветом: полюса – крестиками, нули –
ноликами) и корректирующее звено (красным цветом – полюса и нули).

Рис.5.12. Окно редактирования корректирующего звена

На корневом годографе точки, характеризующие неизменяемую часть
системы и корректирующее звено, выводятся аналогично логарифмическим
частотным характеристикам, с тем лишь отличием, что коэффициент усиления
корректирующего звена для логарифмических частотных характеристик
изменяется с помощью перемещения логарифмической амплитудной
характеристики вверх/вниз (изменение значения L(1)), а для корневого
годографа это изменение осуществляется перемещением квадратиков,
выделенных красным цветом.

Нажимая левой кнопкой мыши на характерные точки графиков, можно
вызвать окна сведений по синтезируемой системе (см. рис.5.11) и
редактирования корректирующего звена (см. рис.5.12). Нажатие правой кнопки
мыши на поле графиков (не на линии) вызывает появление контекстного меню,
полученного сведением пунктов командного меню Edit > Root Locus… или
Bode… и Compensator > Edit…, описанных выше. Вид контекстного меню
зависит от того, на каком из графиков нажать правую кнопку мыши.

Изменяя положение логарифмической амплитудной характеристики
вверх/вниз, можно добиться требуемого запаса устойчивости по амплитуде.
Для синтезируемой в примере системы, чтобы добиться запаса устойчивости по
амплитуде более 20 дБ, необходимо переместить логарифмическую
амплитудную характеристику вниз.

Для того чтобы оценить показатели качества системы при этих
настройках, необходимо получить график переходного процесса, выполнив в
командном меню SISO Design Tool: Tools > Loop Responses… > Plant Output
(Step). При этом появится окно с графиком переходного процесса (рис.5.14).
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Рис.5.13. Пример настройки корректирующего звена

Рис. 5.14. Переходный процесс замкнутой синтезируемой системы

Необходимо заметить, что при любом изменении параметров
корректирующего звена изменяется и график переходного процесса (если окно
активно).
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6. СОДЕРЖАНИЕ ОТЧЕТА
Отчет должен содержать следующие разделы:
6. Титульный лист.
7. Цель и порядок выполнения работы.
8. Краткое изложение теоретической части.
9. Структурная схема САР и его расчленение на ветви.
10.Рисунки экранных панелей при исследовании системы с регулятором.
11.Отыскание оптимальных параметров регуляторов для представленных

требований к системе.
12.Выводы

7. КОНТРОЛЬНЫЕ ВОПРОСЫ
7.1. Для чего служат корректирующие звенья в САР?
7.2. Виды регуляторов.
7.3. Какое из приложений MATLAB-Simulink используется для синтеза

САР?
7.4. В чем заключается суть настройки параметров регулятора?

Лабораторная работа  № 6

ИССЛЕДОВАНИЕ КАЧЕСТВА ПЕРЕХОДНЫХ ПРОЦЕССОВ

1. ЦЕЛЬ  РАБОТЫ
Закрепление теоретических знаний и овладение практическими навыками

по исследованию качества переходных процессов.

2. УКАЗАНИЯ К САМОСТОЯТЕЛЬНОЙ РАБОТЕ
Необходимая информация для подготовки к настоящей лабораторной

работе отражена в теме: «Оценка качества по переходному процессу» в
литературе по ТАУ.

3. ОСНОВНЫЕ СВЕДЕНИЯ
К системам автоматического регулирования (САР) предъявляются

требования не только устойчивости процессов регулирования. Для
работоспособности системы не менее необходимо, чтобы процесс
автоматического регулирования осуществлялся при обеспечении определенных
показателей качества процесса управления. Если исследуемая САР является
устойчивой, возникает вопрос о том, насколько качественно происходит
регулирование в этой системе и удовлетворяет ли оно технологическим
требованиям объекта управления. На практике качество регулирования
определяется визуально по графику переходной характеристики.

Классификация показателей качества состоит из нескольких групп:
· прямые - определяемые непосредственно по переходной

характеристике процесса,
· корневые - определяемые по корням характеристического

полинома,
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· частотные - по частотным характеристикам,
· интегральные - получаемые путем интегрирования функций.
Изменение режима работы автоматической системы возникает в

результате прикладываемых к ней внешних воздействий. При этом возможны
различные режимы работы системы в зависимости от заданного закона
изменения выходной переменной и внешних возмущающих воздействий.
Внешнее возмущение в виде переменной нагрузки наиболее существенно для
систем стабилизации управляемой переменной на заданном уровне. Основная
задача при этом состоит в том, чтобы создать систему, которая не реагировала
бы на это воздействие.

Внешнее воздействие на входе системы наиболее характерно для
программных и следящих систем. При этом надо так выбрать параметры и
структуру системы, чтобы это воздействие воспроизводилось с минимальной
ошибкой (ковариантная задача). В общем случае все эти воздействия на
систему являются сложной функцией времени.

При исследовании качества процесса управления обычно принято
рассматривать несколько типичных воздействий в виде следующих функций:
единичной скачкообразной, импульсной, гармонической и соответствующей
изменению сигнала с постоянной скоростью. Наиболее распространенным
является воздействие в виде скачкообразной функции.

Переходный процесс в системе зависит не только от свойств САУ, но и от
характера внешнего воздействия, которое в общем случае может быть сложной
функцией времени. Поведение системы рассматривают при следующих
типовых воздействиях: единичной ступенчатой функции 1(t), импульсной d(t) и
гармонической функций. Прямые оценки качества получают по кривой
переходной характеристики h(t), т. е. при воздействии единичной ступенчатой
функции и нулевых начальных условиях.

Рис.6.1. Переходные характеристики: а - для выходной координаты h(t); б - для ошибки e(t)

В зависимости от характера затухания при скачкообразном воздействии
переходный процесс может быть монотонным, апериодическим или
колебательным (рис. 6.1). Процесс является монотонным, если отклонение
управляемой переменной от нового установившегося значения при
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¥®t только уменьшается (кривая 2). Процесс считается апериодическим, если
имеет место не более одного перерегулирования относительно начального и
конечного значений управляемой переменной.

Прямыми показателями качества (только они рассматриваются в этой
лабораторной работе) процесса управления, определяемые непосредственно по
переходной характеристике являются:

1. Время регулирования pt  – минимальное время, по истечении
которого переходная характеристика будет оставаться близкой к
установившемуся значению с требуемой точностью, т. е. выполняются
неравенства D£)(te  или D£- yhth )( , где D  – постоянная, заранее
оговариваемая величина, которая задается в процентах от )(yh  (для
статических систем ( )KKyh += 1/)( , а для астатических 1=yh ). Обычно
принимают %5=D .

2. Перерегулирование mH  – максимальное отклонение переходной
характеристики от установившегося значения, выраженное в относительных

единицах или процентах %100)(
y

ym
m h

hhH -
=  или %100

y

m
m h

eH = .

3. Время достижения первого максимума mt .
4. Время нарастания переходного процесса нt  – абсцисса первой

точки пересечения кривой )(th  с уровнем установившегося значения )(yh   или
кривой )(te  с осью абсцисс.

5. Частота колебаний
0

2
T

pw = , где 0T   – период колебаний для

колебательных процессов.
6. Число колебаний N , которое имеет )(th за время pt .
7. Декремент затухания - количественная оценка интенсивности

затухания колебательности переходного процесса:
ym

ym

hh
hh

-

-
=

2

1e .

Для монотонных процессов основным показателем является время
регулирования.

4. ЗАДАНИЕ
1. Для САУ описанной передаточной функцией:

)1)(1( 21 ++
=

pTpTp
kW  и по вариантам указанным в таблице 6.1., используя

пакет MATLAB-Simulink необходимо построить  переходной процесс.
2. По полученному графику определите все прямые показатели качества.
3. Сделайте выводы по результатам.
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Таблица 6.1

№ Т1 Т2 k № Т1 Т2 k
1 0.51 0.11 0.2 11 0.45 1.0 4
2 0.35 1.0 8.56 12 0.56 0.93 5
3 0.13 0.013 13 13 0.89 0.57 89
4 0.46 0.19 3.79 14 0.65 0.3 4.2
5 0.7 0.67 6.67 15 0.2 0.01 8
6 0.98 0.23 9 16 0.54 0.91 3.4
7 0.96 0.99 8.67 17 1.0 0.63 6.7
8 0.5 1.0 3.4 18 0.3 0.44 3
9 0.39 0.83 6.12 19 1.0 0.86 3.8

10 0.99 0.92 90 20 0.34 0.28 5.54

5. СОДЕРЖАНИЕ ОТЧЕТА
Отчет должен содержать следующие разделы:
1. Титульный лист.
2. Цель и порядок выполнения работы.
3. Краткое изложение теоретической части.
4. Структурная схема исследуемой САУ.
5. Графики переходных процессов.
6. Расчет и описание вышеуказанных показателей качества.
7. Выводы.

6. КОНТРОЛЬНЫЕ ВОПРОСЫ
1. Какие типичные воздействия рассматривают при исследовании

качества САУ?
2. Назовите группы показателей качества САУ
3. Почему исследуемые в этой работе показатели качества называются

прямыми?
4. Дайте определение следующим понятиям:
· время регулирование;
· перерегулирование;
· частота колебаний;
· число колебаний;
· достижение первого максимума;
· время нарастания переходного процесса;
· декремент затухания.
5. Какое допустимое значение может принимать перерегулирование?
6. Какое количество колебаний приемлемо в системах управления?
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Лабораторная работа № 7

ХАРАКТЕРИСТИКИ  ЭЛЕМЕНТАРНЫХ  НЕЛИНЕЙНЫХ  ЗВЕНЬЕВ

1. ЦЕЛЬ  РАБОТЫ
Изучение элементарных нелинейных звеньев и исследование их

выходных характеристик.

2. УКАЗАНИЯ К САМОСТОЯТЕЛЬНОЙ РАБОТЕ
Необходимая информация для подготовки к настоящей лабораторной

работе отражена в теме: «Нелинейные системы» в литературе по ТАУ.

3. ОСНОВНЫЕ СВЕДЕНИЯ
Нелинейной системой автоматического регулирования называется такая

система, которая содержит хотя бы одно звено описываемое нелинейным
уравнением. Такое звено называется нелинейным звеном или нелинейным
элементом.

Путем эквивалентного преобразования большое число нелинейных
систем можно представить в виде замкнутого контура с последовательным
включением нелинейного элемента (НЭ) и линейной части (ЛЧ), как показано
на рис.7.1.

Рис.7.1 Схема нелинейной системы: НЭ - нелинейный элемент; ЛЧ - линейная часть

Большая часть модулей нелинейных систем поддается линеаризации и
описывается типовыми динамическими звеньями. Накопленный опыт в
изучении нелинейных систем позволил выделить встречающиеся типовые
нелинейности и систематизировать их. Можно выделить три группы
нелинейных звеньев:

· Нелинейные звенья с однозначными характеристиками (статические
нелинейности);

· Нелинейные звенья с многозначными характеристиками
(динамические нелинейности);

· Особые нелинейные элементы (не поддаются классификации).
Однозначная характеристика звена свидетельствует о том, что кроме

наличия чувствительности к значению входной координаты, звено
нечувствительно ни к направлению движения входной координаты ни к её
производным.

Различают следующие основные типы нелинейных звеньев.
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Нелинейные звенья с гладкими криволинейными характеристиками.
Примеры таких характеристик приведены на рис.7.2.

Рис.7.2 Гладкие криволинейные характеристики:
а - гистерезисная; б, в – усилительные

На рис.7.2,а изображена двузначная гистерезисная (запаздывающая)
характеристика. Характеристика на рис.7.1,б отображает насыщение или
ограничение и соответствует реальному амплитудному усилителю, а
характеристика на рис.7.1,в - реальному усилителю мощности. Характеристики
на рис.7.1,а и б - нечетно-симметричные, а характеристика на рис.7.1,в - четно-
симметричная.

Нелинейные звенья с кусочно-линейными характеристиками.
Некоторые из таких характеристик представлены на рис.7.3.

Рис.7.3. Кусочно-линейные характеристики:а - с насыщением; б - с зоной
нечувствительности;в - с насыщением и зоной нечувствительности; г - люфт

Характеристика на рис.7.3,а отображает насыщение, характеристика на
рис.7.3,б - зону нечувствительности, а характеристика на рис.7.3,в
соответствует звену, обладающему одновременно зоной нечувствительности и
насыщением. Характеристика на рис.7.3,г позволяет учесть люфт или зазор
кинематической передачи.

Релейные звенья - это элементы, которые на своем выходе выдают
конечное число фиксированных значений. Три наиболее типовые релейные
характеристики изображены на рис.7.4.
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Рис.7.4 Релейные характеристики:
а - идеальная; б - с зоной нечувствительности; в - гистерезисная

Характеристика указанная на рис.7.4,а соответствует идеальному
двухпозиционному реле, характеристика на рис.7.4,б - трехпозиционному реле
с зоной нечувствительности, а характеристика на рис.7.4,в - двухпозиционному
поляризованному реле.

Кроме того, на рис.7.4 показано прохождение непрерывного сигнала
через соответствующие типы реле. Откуда следует, что коэффициент передачи
реле зависит от величины входного воздействия.

Для улучшения динамических свойств систем специально созданы
нелинейные звенья с опережающими двузначными статическими
характеристиками.

Часто встречаются элементы с несимметричными относительно начала
координат статическими характеристиками.

Раздел Nonlinear основной библиотеки MATLAB-Simulink, посвященный
нелинейным компонентам, содержит наиболее распространенные нелинейные
блоки (рис. 7.5).

Рис. 7.5. Окно пакета Simulink
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4. ЗАДАНИЕ
4.1. В библиотеке Nonlinear пакета Simulink выбрав один из указанных

нелинейных блоков построить модель, показанную на рисунке 7.6. В качестве
источника входного сигнала использовать синусоиду Sine Wave из блока
Sources. Для удобства сравнения сигналов – исходного и прошедшего через
нелинейный блок – используем блок Mux (мультиплексор) из раздела Signal &
Systems библиотеки Simulink. На входы блока Mux (на рис. 7.6 он обозначен
черным прямоугольником) подаются соответствующие сигналы, а выход
присоединяется к блоку Scope.

Рис. 7.6. Пример модели нелинейной системы для проведения исследования

4.2. Меняя нелинейные блоки в схеме модели указанной на рис 7.6., в
следующей последовательности:

- блок Saturation (звено с ограничением или насыщением);
- блок с зоной нечувствительности Dead Zone;
- релейный блок Relay,
необходимо получить их модели.
4.3. Параметры блоков для соответствующих вариантов заданий

представлены в табл.7.1.
4.4. В соответствии с вариантом настройте их параметры. Изучите

статические характеристики типовых нелинейностей, подавая на вход
гармонический сигнал.

4.5. По результатам исследований необходимо сделать выводы о
физическом смысле этих типовых нелинейных характеристик.
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Таблица 7.1
Х
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№ варианта Параметр b

Х
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№ варианта Параметр b
1 0,7 1 2,3
2 1,3 2 1,7
3 2,8 3 0,3
4 3,5 4 4,8
5 4,2 5 3,4
6 5,6 6 5,6
7 6,9 7 2,1
8 1,7 8 6,9
9     2,3 9 3,5
10 0,9 10 5,4
11 3,7 11 2,8
12 5,2 12 6,9
13 3,3 13 2,3
14 2,7 14 1,9
15 1,3 15 2,3
16 4,9 16 5,8
17 3,6 17 2,4
18 5,8 18 5,6
19 2,3 19 2,1
20 5.9 20 3,9

Х
ар

ак
те

ри
ст

ик
а 

с 
ги

ст
ер

ез
ис

ом

№ варианта Параметр a Параметр b
1 2 0,7
2 1,1 1,4
3 2 2,8
4 0,5 0,9
5 3,3 3,7
6 0,9 1,5
7 3,7 4,3
8 2,2 2,6
9 1,5 3,1

10 4,8 3,7
11 8,9 2,5
12 5,3 1,3
13 1,5 3,7
14 4,3 2,2
15 2,6 1,5
16 3,1 4,8
17 3,7 8,9
18 2,5 5,3
19 1,3 1.8
20 2.4 3.5
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5. СОДЕРЖАНИЕ ОТЧЕТА
Отчет должен содержать следующие разделы:
1. Титульный лист.
2. Цель и порядок выполнения работы.
3. Краткое изложение теоретической части.
4. Три схемы моделей с нелинейным звеном.
5. Осциллограммы выходных функций.
6. Выводы.

6. КОНТРОЛЬНЫЕ ВОПРОСЫ
1. Какие можно выделить группы нелинейных звеньев?
2. Назовите существующие типовые нелинейности?
3. Какой раздел библиотеки Simulink используется для исследования

нелинейных систем?
4. Приведите примеры и поясните физическую природу нелинейных

эффектов в САУ.
5. Назовите нелинейный блок описываемый следующим

уравнением:

ï
î

ï
í

ì

-<-
>

£

=
,bXприB

,bXприB
,bXприkX

Y где k = tg a.

6. Что называется статической характеристикой и с какой целью ее
определяют?

7. По каким признакам различаются нелинейные системы от
линейных систем? Приведите несколько примеров.

Лабораторная работа 8

ИССЛЕДОВАНИЕ  РЕЛЕЙНЫХ СИСТЕМ
МЕТОДОМ ФАЗОВОЙ ПЛОСКОСТИ

1. ЦЕЛЬ  РАБОТЫ
Исследование динамики нелинейных систем второго порядка методом

фазовой плоскости.

2. УКАЗАНИЯ К САМОСТОЯТЕЛЬНОЙ РАБОТЕ
Необходимая информация для подготовки к настоящей лабораторной

работе отражена в теме: «Нелинейные системы» в литературе по ТАУ.

3. ОСНОВНЫЕ СВЕДЕНИЯ
Метод фазовой плоскости используется для исследования нелинейных

систем, линейная часть которых описывается дифференциальным уравнением
не выше второго порядка, а нелинейный элемент может быть любым. Метод
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заключается в том, что из уравнений состояния исключается время и
определяются уравнения фазовых кривых. Задача значительно упрощается,
если нелинейный элемент обладает кусочно-линейной характеристикой. Тогда
фазовое пространство разбивается на ряд областей, где работа нелинейной
системы описывается обыкновенными линейными уравнениями, на основании
которых строятся фазовые траектории. Непрерывность движения
изображающей точки на фазовом пространстве (переход из одной области в
другую) обеспечивается ”сшиванием” по линиям переключения в соответствии
с видом нелинейности. При исследовании нелинейных систем высокого
порядка их аппроксимируют системами второго порядка с эквивалентным
запаздыванием.

Для изображения процессов на фазовой плоскости нелинейное уравнение,
описывающее систему, заменяют эквивалентными уравнениями первого
порядка вида

ï
î

ï
í

ì

=

=

,

);,(

y
dt
dx

yxf
dt
dy

где x, y - координата системы и ее первая производная; f(x, y) - нелинейная
функция.

Разделив первое из уравнений на второе, получим дифференциальное
уравнение, из которого исключено время t:

.),(
y

yxf
dt
dy

=

Решение данного уравнения
y = F(x)

определяет уравнение фазовой траектории, которая графически
изображается на фазовой плоскости (x, y). Каждой совокупности начальных
условий (x0,  y0) соответствует свое решение и своя фазовая траектория.
Семейство фазовых траекторий характеризует все возможные виды переходных
процессов в данной системе управления при любых начальных условиях и
образует ее фазовый портрет.

Если по линейной теории система неустойчивая и процесс расходится, то
может оказаться, что из-за фактической нелинейности характеристик он не
будет расходящимся неограниченно. Картина фазовых траекторий для такой
системы изображена на рис.8.1,а. Здесь вблизи начала координат получаются
спирали, как в неустойчивой линейной системе, но далее они приближаются
асимптотически к замкнутому контуру ограниченных размеров. К нему же
приближаются и все спирали, находящиеся вне контура. Такого рода
замкнутый контур представляет собой особый вид линий на фазовой плоскости
и называется устойчивым предельным циклом. Устойчивый предельный цикл
соответствует автоколебаниям системы.

Размеры предельного цикла представляют амплитуды колебаний самой
величины x и скорости ее изменения y. Для определения периода
автоколебаний необходимо решить уравнение системы во времени.
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Рис.8.1. Фазовые траектории нелинейных систем:
а - устойчивый предельный цикл; б - неустойчивый предельный цикл;

в - фазовый портрет системы с сепаратрисами

Замкнутые фазовые траектории на фазовой плоскости называются
предельными циклами, которые могут быть как устойчивыми (рис.8.1,а), так и
неустойчивыми (рис.8.1,б). К этим предельным циклам стремятся
изображающие точки при различных начальных отклонениях по различным
фазовым траекториям.

В различных частях фазовой плоскости фазовые траектории нелинейной
системы могут быть различными (рис.8.1,в). Линии, разделяющие фазовую
плоскость на участки с различными фазовыми траекториями, называются
сепаратрисами. Поведение системы в каждой области фазовой плоскости
описывается своим дифференциальным уравнением.

Кроме того, для фазового портрета нелинейных систем с разрывными
характеристиками характерно наличие линий переключения, которые также
разделяют фазовую плоскость на ряд областей с различными фазовыми
траекториями. При этом начальные значения переменных на каждом участке
определяются через их конечные значения на предыдущем участке. Линии
переключения характеризуются узловыми точками разрывных характеристик
нелинейных элементов.

4. ЗАДАНИЕ
Первая часть
1. В соответствии со структурной схемой на рис.8.2 смоделируйте

систему управления, у которой реле имеет характеристику вида рис.8.3, а

передаточная функция задана соотношением p
kpW =)(0 . Значение коэффиента

передачи (k) возьмите из табл.8.1.
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Рис.8.2. Структурная схема исследуемой
системы

Рис. 8.3. График релейного звена

2. Для случая идеального двухпозиционного реле, отсутствия
коррекции по скорости и нулевого входного сигнала, т.е. при d = 0, b = 0, g = 0,
задайте начальное отклонение x10 при х20 =  0 и пронаблюдайте фазовую
траекторию, соответствующую свободному движению системы. Коэффициенты
передачи интеграторов в модели выбирайте произвольно, исходя из удобства
наблюдения изображения.  Зарисуйте фазовый портрет системы, а также
пронаблюдайте и зафиксируйте процессы х1(t) и x2(t).

3. В этой же системе введите коррекцию по скорости, полагая b ¹ 0, и
зарисуйте вид фазовых траекторий при b = 0,25; 0,5; 1. Каждой из полученных
фазовых траекторий поставьте в соответствие процессы х1(t) и x2(t). В случае
сильной коррекции, приводящей к возникновению скользящего режима,
обратите внимание на вид сигнала на выходе релейного элемента. Дайте
объяснение полученному результату.

4. Что Вы ожидаете получить результат, если обратную связь по
скорости выбрать положительной? Проверьте Ваше предположение
моделированием.

5. Измените, вид релейной характеристики, введя зону
нечувствительности, т.е. задайте d¹ 0 при m  =  1. Предскажите вид фазового
портрета и проверьте Ваше предположение, моделированием системы,
рассматривая свободное движение при отсутствии коррекции по скорости.

6. Задайте начальное отклонение ÷х10÷ > d  при х20 =  0 и
пронаблюдайте фазовую траекторию при отсутствии коррекции по скорости,
изменяя величину зоны нечувствительности.

7. Введите коррекцию по скорости, задавая b = 0,25; 0,5; 1. Зарисуйте
вид процессов х1(t) и x2(t) при заданной степени коррекции.

8. Реализуйте релейную характеристику гистерезисного типа, задавая
d¹ 0 и m  =  -1. При b =  0 задайте малое начальное отклонение ÷х10÷ < d  и
пронаблюдайте фазовый портрет и процессы х1(t) и x2(t).

9. Введите коррекцию по скорости и пронаблюдайте для b = 0,25; 0,5;
1 фазовые траектории, соответствующие отработке малых ÷х10÷ < d  и больших
÷х10÷ > d начальных отклонений. В чем принципиальное отличие этих
траекторий? Как зависят от степени коррекции по скорости параметры
предельного цикла и соответствующих ему периодических колебаний?
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10. Реализуйте релейную характеристику с гистерезисом и зоной
нечувствительности, задавая d¹ 0 и 0 < m < 1.

11. При b = 0 задайте начальное отклонение и пронаблюдайте фазовый
портрет и соответствующие ему процессы х1(t) и x2(t).

12. Введите коррекцию по скорости, задайте начальное отклонение
÷х10÷ > d  и для различных b, исследуйте вид фазовой траектории. Зарисуйте
фазовые портреты и процессы х1(t) и x2(t).

Вторая часть
13.  По результатам пп.1-12 сделайте выводы о динамических

свойствах системы управления объектом с передаточной функцией

2)(
p
kpW = .

14. В системе управления со структурной схемой (рис.8.2) реализуйте
идеальное двухпозиционное реле, задавая W0(p) линейной части передаточной

функцией вида 1
)(0 +
=

Tp
kpW . Значения коэффициента передачи (k)   и

постоянной времени (Т) возьмите из табл.8.1.
15.  Задайте начальное отклонение х10, при х20=0 и пронаблюдайте

фазовую траекторию и процессы х1(t) и x2(t) при отсутствии коррекции по
скорости.

16. К чему приводит введение обратной связи по скорости? Что
произойдет, если знак обратной связи по скорости выбран неправильно? Ваши
ответы проверьте моделированием. Пронаблюдайте и зафиксируйте
соответствующие фазовые портреты и процессы х1(t) и x2(t).

17. В релейной характеристике введите зону нечувствительности, т.е.
задавая d¹ 0 при m=1.

18. Задавая различные начальные отклонения, удовлетворяющие
условию ÷х10÷ > d , пронаблюдайте фазовые траектории при отсутствии
коррекции по скорости.

19. Введите коррекцию по скорости и исследуйте ее влияние на
динамику системы при одних и тех же начальных отклонениях ÷х10÷>d.

20. Реализуйте релейную характеристику гистерезисного вида, задавая
d¹ 0 при m= -1.

21. Пронаблюдайте фазовые траектории и процессы х1(t) и x2(t) при
отработке малых ÷х10÷ < d  и больших ÷х10÷ > d начальных отклонений, изменяя
величину коррекции по скорости и начиная со значения b = 0.

22. Реализуйте релейную характеристику с гистерезисом и зоной
нечувствительности, задавая d ¹ 0 и 0 < m < 1.

23. Задайте начальное отклонение ÷х10÷ > d и пронаблюдайте фазовые
траектории, а также процессы х1(t) и x2(t) при различной степени коррекции по
скорости. Полученные результаты зафиксируйте.
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Третья часть
24. По результатам пп.13-23 сделайте выводы о динамических

свойствах системы управления объектом с передаточной функцией

)1(
)(

+
=

Tpp
kpW . Значения коэффициента передачи (k)  и постоянной времени

(Т) возьмите из табл. 8.1.
25. В системе управления со структурной схемой  (рис.8.2) реализуйте

идеальное двухпозиционное реле, задавая W0(p) линейной части передаточной

функцией вида 1
)(0 -
=

Tp
kpW .

26. Задавайте малое начальное отклонение х10 и пронаблюдайте
фазовый портрет при отсутствии коррекции по скорости. Каков Ваш вывод о
работоспособности системы управления?

27. Введите коррекцию по скорости b =  0,2. Постепенно увеличивая
начальное отклонение х10 , сделайте вывод о возможных режимах работы
системы управления. Полученные результаты зафиксируйте в виде фазовых
портретов и графиков х1(t) и x2(t).

28. Определите величину начального отклонения, которое при b =  0,2
система не может устранить. Увеличивая степень коррекции по скорости,
добейтесь наблюдения сходящего процесса. Попытайтесь выделить и
пронаблюдать на экране индикатора границу между двумя качественно
отличными режимами работы системы управления. Какие Вы испытываете
затруднения? Объясните их причину.

29. Реализуйте релейную характеристику с зоной нечувствительности,
задавая d ¹ 0 и m=1.

30. При наличии коррекции по скорости исследуйте динамику системы
управления, задавая малые отклонения в соответствии с условиями: х10 <0; х10
>0, при х10 =0.

31. При наличии коррекции по скорости и больших начальных
отклонениях поварьируйте величину коррекции и зарисуйте фазовые портреты
и графики х1(t) и x2(t).

32. Реализуйте релейную характеристику с гистерезисом и зоной
нечувствительности, задавая d ¹ 0 и 0 < m < 1.

33. Изменяя величину коррекции по скорости, при начальном
отклонении ÷х10÷ > d, пронаблюдайте вид фазовых траекторий. Сравните
внешний вид фазовых траекторий, полученных при сильной коррекции по
скорости, для случая однозначной и неоднозначной характеристик реле с зоной
нечувствительности.

34. По результатам пп. 24-33 сделайте вывод о динамических свойствах
системы управления динамическим объектом с передаточной функцией вида

)1(
)(

-
=

Tpp
kpW , рассматривая случаи однозначных и неоднозначных

релейных характеристик.
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Таблица 8.1
№ 1 2 3 4 5 6 7 8 9
k 1,1 9,4 4,6 5,7 2,2 8,3 3,5 6,8 7,9
T 0,44 0,36 0,85 0,22 0,73 0,58 0,11 0,96 0,69

5. СОДЕРЖАНИЕ ОТЧЕТА
Отчет должен содержать следующие разделы:
1. Цель работы.
2. Описание метода фазовой плоскости.
3. Задание на лабораторную работу.
4. Результаты моделирования.
6. Выводы

6. КОНТРОЛЬНЫЕ  ВОПРОСЫ
1. Почему метод фазовой плоскости относят к точным методам

исследования нелинейных систем ?
2. Какие Вам известны типы особых линий ?
3. Что такое предельный цикл?
4. Что называется линией переключения ?
5. Как построить линию переключения ?
6. Что такое скользящий режим ?
7. Как по фазовой траектории определить поведение системы во

времени ?

ЛАБОРАТОРНАЯ РАБОТА № 9

ИССЛЕДОВАНИЕ НЕЛИНЕЙНЫХ СИСТЕМ МЕТОДОМ
ГАРМОНИЧЕСКОГО БАЛАНСА

1. ЦЕЛЬ  РАБОТЫ
Практическое овладение методом гармонического баланса для анализа

устойчивости замкнутых нелинейных систем.

2. УКАЗАНИЯ К САМОСТОЯТЕЛЬНОЙ РАБОТЕ
Необходимая информация для подготовки к настоящей лабораторной

работе отражена в теме: «Нелинейные системы» в литературе по ТАУ.

3. ОСНОВНЫЕ СВЕДЕНИЯ
В соответствии с критерием устойчивости Найквиста незатухающие

колебания в линейной системе возникают в том случае, когда амплитудно-
фазовая характеристика разомкнутой системы проходит через точку с
координатами [-1, j0]. Данное условие является также условием существования
автоколебаний в гармонически линеаризованный нелинейной системе, т.е.

Wн(jw, a) = -1.
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Так как линейная и нелинейная части системы соединены
последовательно, то частотная характеристика разомкнутой нелинейной
системы имеет вид

Wн(jw, a) = Wлч(jw)*WЭ(jw, a).
Тогда в случае статической характеристики нелинейного элемента

условие принимает вид

Wлч(jw) = - .
)(

1
аWЭ

Решение уравнения относительно частоты и амплитуды автоколебаний
можно получить графически как точку пересечения годографа частотной
характеристики линейной части системы Wлч(jw) и годографа обратной

характеристики нелинейной части - )(
1

аWЭ
, взятой с обратным знаком. Если

эти годографы не пересекаются, то режим автоколебаний в исследуемой
системе не существует.

Для устойчивости автоколебательного режима с частотой w0 и

амплитудой a0 требуется, чтобы точка на годографе нелинейной части - )(
1

аWЭ
,

соответствующая увеличенной амплитуде a0 + Δa по сравнению со значением в
точке пересечения годографов, не охватывалась годографом частотной
характеристики линейной части системы и охватывалась точка,
соответствующая уменьшенной амплитуде a0 - Δa.

На рис.9.1 дан пример расположения годографов для случая, когда в
нелинейной системе существуют устойчивые автоколебания, так как

a3 < a0 < a4 .

Рис.9.1. Годографы линейной и нелинейной частей системы

4. ЗАДАНИЕ
1. Структурная схема исследуемой системы управления представлена

на рис.9.2. В результате теоретического анализа определите возможность
возникновения в этой системе режима автоколебаний для нелинейностей и
передаточные функций, приведенных в табл.9.1, постоянную времени Т, брать
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из табл.9.2, согласно своему варианту. Клетки таблиц заполните ответами,
указав для однозначных нелинейностей расчетные значения параметров
автоколебаний.

2. Разработайте методику исследования режима автоколебаний на
ЭВМ. Проверьте моделированием теоретические результаты п. 1.

3. Разомкните обратную связь и на вход сумматора подайте
гармонический сигнал. Изучите форму сигналов на выходе нелинейности, а
также на выходе первого, второго и третьего апериодических звеньев, варьируя
частоту входного сигнала, для всех нелинейностей указанных в табл. 9.1.
Отметьте, как в графиках сигналов проявляется фильтрующее свойство
линейной части системы управления.

4. Замкните обратную связь. Реализация последнего из
апериодических звеньев с использованием сумматора, позволяет получить
сигнал, пропорциональный производной от сигнала на выходе линейной части
системы управления. Используя эту возможность, пронаблюдайте фазовые
траектории исследуемой системы управления, рассматривая линейную часть с

передаточной функцией вида 2)1(
1)(
+

=
Tp

pW  и нелинейности указанные в

табл. 9.1.
5. Варьируя начальные условия или амплитуду входного сигнала,

зафиксируйте фазовые траектории, соответствующие устойчивым и
неустойчивым предельным циклам. Изучите процессы установления
автоколебаний и зафиксируйте графики.

Рис. 9.2. Структурная схема нелинейной системы

Таблица 9.1
F(e) W0(p)

)1(
1
+Tp 2)1(

1
+Tp 3)1(

1
+Tp

1
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2

3

4

Таблица 9.2
№ 1 2 3 4 5 6 7 8 9 10
Т 0,9 0,15 0,7 0,45 0,3 0,6 0,28 0,5 0,75 0,9

5. СОДЕРЖАНИЕ ОТЧЕТА
Отчет должен содержать следующие разделы:
1. Цель работы.
2. Описание метода гармонического баланса.
3. Задание на лабораторную работу.
4. Результаты моделирования.
6. Выводы

6. КОНТРОЛЬНЫЕ  ВОПРОСЫ
1. Сформулируйте общую постановку задачи анализа нелинейной

системы методом гармонического баланса.
2. Что позволяет определить – метод гармонического баланса в

результате анализа нелинейной и системы?
3. Что такое автоколебания?
4. Какой вид имеет уравнение Гольдфарба и что оно описывает?
5. Сформулируйте понятие устойчивости система управления в

режиме автоколебаний?
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Лабораторная работа № 10

ИССЛЕДОВАНИЕ ИМПУЛЬСНЫХ СИСТЕМ УПРАВЛЕНИЯ

1. ЦЕЛЬ  РАБОТЫ
Получение передаточных функций дискретных систем управления, путем

применения z-преобразования; исследование временных характеристик
дискретных систем управления.

2. УКАЗАНИЯ К САМОСТОЯТЕЛЬНОЙ РАБОТЕ
Необходимая информация для подготовки к настоящей лабораторной

работе отражена в теме: «Импульсные системы» в литературе по ТАУ.

3. ОСНОВНЫЕ СВЕДЕНИЯ
Характерная особенность импульсных систем заключается в том, что, по

крайней мере, одна из координат (переменных) в них подвергается
квантованию (прерыванию) по времени. Эти квантованные по времени
величины при помощи импульсной модуляции преобразуются в
последовательность импульсов, которые воздействуют на непрерывную часть
системы. Процесс квантования и импульсной модуляции осуществляется
импульсным элементом.

Таким образом, импульсная система состоит из импульсного элемента
(ИЭ) и непрерывной части (НЧ), составленной из типовых динамических
звеньев (рис.10.1).

Рис.10.1. Функциональная схема импульсной системы:
ИЭ - импульсный элемент; НЧ - непрерывная часть

В импульсной системе импульсный элемент преобразует непрерывно
изменяющуюся величину в последовательность модулированных импульсов
(рис.10.2).

Рис.10.2. Временные диаграммы изменения сигналов на входе x и
выходе x* импульсного элемента
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Z-преобразование. Подобно тому, как применение преобразования
Лапласа к линейным дифференциальным уравнениям дало возможность
получить удобную методику анализа непрерывных систем, для дискретных
систем также был разработан ряд специальных преобразований. Из них
наибольшее распространение получили дискретное преобразование Лапласа z-
преобразование.

Z-пребразованием решетчатой функции x[nT] называется функция
комплексного аргумента z, определяемая выражением

{ }X(z) = Z x[nT] x[nT] z- n

n = 0

= ´å
¥

при çzô>R=1/r , где r - радиус сходимости ряда.
Функция x[nT] называется оригиналом, а функция X(z) - изображением

или z-пребразованием функции x[nT].
Преобразование, в котором z  =  esT, было введено Я.З.Цыпкиным под

названием “дискретное преобразование Лапласа”.
Z-пребразование дает возможность получить из X(z) значение ординат

решетчатой функции x[nT] в моменты квантования. Но в системах управления с
непрерывными динамическими частями процесс непрерывен и между
моментами n = 0, 1, 2 ...  Для нахождения этих ординат необходимо рассмотреть
последовательности для других дискретных моментов с тем же интервалом
повторения, но смещенных на значение sT:  t  =  (n+s)T при 0 £ s £ 1.  Это
можно делать с помощью модифицированного z-преобразования.

Таблица 10.1
Z - преобразования функций времени

x(t) X(s) x[nT] X(z)
d(t) 1 d[nT] 1
1(t) 1/s 1[nT] z/(z-1)

t 1/s2 nT Tz/(z-1)2

 te a- 1/(s+a) e d nT n- =a z/(z-d)
(d= e  T-a )

t2/2! 1/s3 (nT)2/2! T z(z+1)

2!(z 1)

2

3-

te  t-a 1/(s+a)2

nTe  nT-a zdT

(z d)2-

(d= e  T-a )

t
2!

e
2

a t- 1/(s+a)3 (nT)
2!

e
2

 nT-a z(z+ d) dT

2!(z d)

2

3-

(d= e  T-a )
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4. ЗАДАНИЕ

1. Даны передаточные функции s
sW 1)( = ; )(

1)(
a+

=
s

sW ;

2)(
1)(
a+

=
s

sW . Исследуйте их временные характеристики (переходная

характеристика, весовая характеристика), коэффициент α возьмите из табл.10.2
2. Примените z-преобразование получите передаточные функции

дискретных объектов.
3. Полученные математические модели реализуйте в виде блоков

библиотеки MATLAB SIMULINK (Discrete). Исследуйте временные
характеристики.

4. Полученные результаты сравните с временными характеристиками
непрерывных объектов. Сделайте вывод.

Таблица 10.2
№ 1 2 3 4 5 6 7 8 9 10
α 0,9 0,3 0,4 0,6 0,2 0,5 0,1 0,7 0,8 1,1

5. СОДЕРЖАНИЕ ОТЧЕТА
Отчет должен содержать следующие разделы:
1. Цель работы.
2. Теоретические сведения о дискретных системах.
3. Задание на лабораторную работу.
4. Результаты моделирования. Графики временных характеристик.
6. Выводы

7. КОНТРОЛЬНЫЕ  ВОПРОСЫ
1. Сформулируйте определение дискретных систем. Какова структура

и классификация импульсных систем?
2. Поясните методы определения передаточных функций импульсных

систем.
3. Каким образом определяются частотные характеристики

импульсных систем?
4. Какими способами определяются переходные процессы в

дискретных системах?
5. Сформулируйте условия устойчивости импульсных систем.
6. Каков порядок синтеза цифровых систем?
7. Запишите стандартную форму уравнений в пространстве состояний.

Поясните физический смысл уравнений.
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